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BATCH OPERATION 

FS2000 uses a number of distinct processes during the course of analysis.  The analysis of a load case or the 

creation of formatted results data are typical examples of such processes.   

Definition tasks would normally be undertaken in FS2000’s GUI or occasionally using text command line 

definition. Either way requires a high degree of unavoidable direct user interaction.  

Once the model and load cases are created, they are solved and resulting output is created to the suit the 

particular requirements of the job. The activation and control of these processes can be achieved by Direct 

User Interaction within FS2000’s GUI i.e. using the various menu options and related data selection forms. 

For large models or models with numerous load cases it is often more convenient and almost essential to 

activate and control of these processes automatically because in any job the analysis will be undertaken a 

number of times.   

The automation of these processes in FS2000 is called Batch Operation where each process is started using 

command line instructions (arguments). Command line instructions can be incorporated into batch script 

files (Batch Control Files) to enable the user to set up repeatable multiple processing that eliminates user 

intervention. 

 

RUNNING A MODEL IN BATCH MODE 

BATCH PROCESS CONTROL 

Batch files are run using FS2000’s Batch Process Control (BPC) Module. This is a separate Windows 

application and can be used to run different models to that loaded in FS2000’s GUI. From now the BPC will 

be called the Batch. 

In addition to the execution of the FS2000’s processes, the module can interpret some simple file commands 

and execute any Windows application. 

 

The batch file can be used to modify models as the solution 

progresses. An example of this would be to assess sensitivity 

effects due to property variation or changes in geometry e.g. 

different crane boom positions.  

 

The illustration shows the type of batch file used for offshore 

fatigue analysis.  Note that these types of batch files are 

created by a special fatigue utility program. 

 

 

 

 

The Help file describes the use of the module and lists the command line switches.  
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OPEN THE DEMONSTRATION MODEL 

You will first open a model from Archive format.  This model is called PropCant.  This model was the subject 

of the second basic tutorial. 

From the File menu, click Open.  Change the File of Type from Std Models to Archive Models. Now select 

‘PropCant.mod’ from the FS2000\Examples directory. 

The Model Recovery form will prompt for a recipient directory.  Select a directory or use the default. 

Click the Recover button to open the model. 

The model is a propped cantilever with 3 load cases and a load case combination that contains all 3 load 

cases. 

1. STARTING THE BATCH PROCESS CONTROL 

Click the Batch button (upper LHS).   

This will start the Batch Process Control application. When the program starts it will ether 

load the current batch file i.e. the last one used or in the case of a newly opened model, the 

<modelname>.BRM file. In this example the BRM file will be opened. 

When loaded the following Btach form will become visible. 

 

Do not be put off by the command line switches as it is not necessary to know what these do, this will 

become apparent later. 

Click the Run Batch Job button.    

This will start the analysis process.   

When it stops Click the View Log this will show if and what errors occurred during the analysis.   

If the batch ran successfully all the results will exist. 

Close the log viewer and Close the Batch. 

You can now look at some of the results created during the batch run. 
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2. OPENING A SAVED VIEW  

Although nothing to do with batch operation, it is useful at this stage to also introduce Saved Views. 

To look at the results we will open a saved view (see Section 4.8 in the Help for a description of saving and 

opening views). This illustrates how batch running and saved views can be conveniently used to see the 

‘cause and effect’ of model changes. 

In this example the Von-Mises stress ratio (UR) is the performance criteria. 

 

Click the Open View From File Button  (blue folder).   From the View list select View 1.  This view 

shows the maximum Von-Mises UR values for each element from 3 load cases.   

Notice how the view has changed the current TASK to Output/Results from the Primary TASK.  Saved views 

have a very useful purpose - experiment. 

Use the File menu Open Proc Results command to view other types of results.   

The text mode output may also be viewed from the Data menu using the View/Print Data sub-menu 

commands. The Report Collation-Data Selection can also show in a convenient manner what formatted 

model data has been created. 

 

The above batch file shows how an analysis process can be initiated, completed and the results interrogated 

with minimal user interaction i.e. just a few mouse clicks.  For complex models with multiple Load Cases and 

multiple Load Case Combinations it is essential to use Batch Mode Operation. 

USE BATCH MODE AND LET THE COMPUTER DO THE WORK. 
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3. BATCH COMMAND LINE INSTRUCTIONS 

The Batch Control File is simply a text file that contains module command line instructions.  The example 

below lists the command line switches used by the Standard Out – Individual Output process. 

OUT6  C1/C2/C3/C4/C5/C6/C7/C8/C9/C10/C11/C12/C13/     

C1        is the processed results file  0 to 9999 
           Ranges may be processed  e.g.  1-10  would process Results Cases 1 to 10  

C2        Displacements  0-off, 1-on 
C3        Element Forces 0-off, 1-on 

C4        Number of locations on span for forces .   0-default is 3 

C5        Spring Forces        0-off,  1-on 
C6        Reactions              0-off,  1-on 

C7        Stress Output 1-at all points, 2-max combined, 0-no stress output 
C8        Number of locations on span for stress output .   0-default is 3 

C9        Stress limit for printing output stresses.  Default 0 
C10     Group SET to read 

C11     Group Limit/Restriction 

C12     Groups Only switch 
C13     Subcase Name 

If C1 is preceded by - the output will be in Engineers Units.    

In the batch file for this example the OUT6 command appears as: 

OUT6 -1-3/1/1/3/1/1/1/3/0/0/-9000/0/ 

A batch file could be created in a text editor but this would require a detailed knowledge of the command 

line switches for each module being used.  It is far easier to use the interactive forms of FS2000 to add 

entries to the batch file.   

In practice when working with and editing live batch files it is only necessary to know the process name e.g. 

POST6 and the cases it processes i.e. C1 

The easy forms approach will now be demonstrated by re-creating the batch file just used. 

Module command line switches are given in Section 10.5 of the Help file. 
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4. OPENING A NEW BATCH FILE 

In this demonstration we are going to create a new batch file. Batch file are identified by their file extension. 

The previous batch file example used the default extension BRM i.e <modelname>.BRM. 

We could continue to use this batch file and append and delete command as required but for the purpose of 

the demonstration a new batch file will be created. This will be called BRM_New. 

Use the batch button  to open the Batch form. 

It will load the Current batch file - BRM.  A Current 

batch file is the one last loaded. 

 

To create a new batch file the name is changed and 

the file saved.  

 

 

 

Change the Control File name to BRM_New, then click the Save Batch File button. The Get Batch File button 

could be used to confirm. 

The exiting command line instructions are not required so click the Delete All to remove them. 

Re-save the batch file. 

Use the Close button, now re-open again using the Batch button. 

The Current batch file should be BRM_New and the file should be empty as shown below. It is now ready to 

accept new command lines using the forms approach. 
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5. THE ANALYSIS STAGE 

Unless load generators are being used this is the first section of a batch file. 

From the  TASK menu click Analysis,  then Solution,  then 3-D Standard (Front) command.    

The Analysis form should now be visible. 

 

Activate the X Direction for the Wavefront. 

Activate  PostProcessing. 

Select Combination. Click the Browse button and select 

Combination 10 from the list. 

Click the Batch button.  The following confirmation box will 

appear. 

 

Use the F1 key to get Help on the Analysis form’s solution option. The 

Wavefront Optimiser is not important in this small model but its use MUST 

be understood for larger models. 

 

 

 

This list box lists the processes that would have been undertaken if the Solve button had been clicked and 

more significantly the commands that will be appended to the bottom of the Current Batch file.  Effectively 

the Batch button on this form and all other similar process forms is a method to record what is done 

interactively so the next time it can be done automatically in a batch run using a batch file.  

The following is a summary of the processes to be added to the batch file: 

WAVESORT Internally re-sequence the model for solution 

LOADA  Prepare the indivudual load cases in C10 for solution 

OFRAME  Solve for each of the load cases in C10 (no factors applied) 

POST6  Combine (add and factor) all the load cases in C10 and produce Result Case 10 

 

Click the OK button. 

Open the Batch and the appended command should be visible.  If the Batch is already open then close and 

re-open or use the Get Batch File button to load the updated file. 

Click the Run Batch Job button and view the Log. Result Case 10 will now exist and there will be 3 raw (non-

processed) result cases from the solution stage. 

 

 

More efficient batch files can be created if a basic understanding of the solution option in FS2000 is gained. 

To this end a more detailed discussion on the different ways to undertake the solution stage is given in 

Section 10. 
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6. POST-PROCESSING 

In this example we also require to produce individual processed result cases for each of the 3 load cases. 

Click the PostPro menu command - the Post-Processing form will become visible.  If the batch file has been 

run the browse button can be used to view/select existing cases that may be post-processed. 

 

 

 

In this example we are to process all three cases so enter 1-3 in the case box and click the form’s Batch 

button. 

 

 

Click the OK button to append the command to the end of the Current batch file.  

You may also click the OK button to process the result cases 1 to 3.  If they don’t exist warning will be given. 
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7. CREATING THE FORMATTED RESULTS DATA 

First the Standard Results file will be created. 

From the TASK menu select the Output/Result TASK. 

From the StdOut menu select the Individual Results Format and add the following two lines to the batch 

file. Note the zero stress limits. 

 

 

 

It should be noted that it would be permissible to use the range 1-10. In this case the batch log would give 

warning that case 4 to 9 could not be found.  The double entry approach gives a cleaner log with no errors 

but sometimes it is more convenient to accept the errors warnings regarding missing files. 

From the StdOut menu select the Multiple Results Format and add the following line to the batch file. 

Note the zero stress limits. 

 

 

The final results to be created are the sorted Von-Mises UR ratios for all cases. 

From the StdOut menu select the Sorted Unity Ratios (UR) and add the following line to the batch file.  

Note the zero stress limits. 
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8. DEFINITION DATA FORMATTING 

The end of a batch file is a convenient point to produce a formatted report containing the definition data. 

This ensures that a full record of both the inputs and outputs from the model are created. 

From the Data menu click Format Definition data.   The Definition Data - Formatted Output File form 

should now be visible.   

 

Click the Select All Options button, then the Batch button to add the command to the current batch file. 

The batch file is now complete. 

  



FS2000 Analysis  

Batch Operation Tutorial 

9. VIEW & RUN THE BATCH FILE 

Use the batch button  to open the Batch form. If it is already open, click the Get Batch File button. 

It will load the Current batch file – BRM_New, which should look like the one below if the instructions were 

followed correctly.   

 

 

Click the Run Batch Job button and the solution will run.  When completed view the log.  There should be no 

errors. 

Click the Open View From File Button  (blue folder).   From the View list select View 1.  This view 

shows the maximum Von-Mises UR values for each element from 3 load cases. The display should look like 

the one below. 

 

The Edit File button will open the current batch file in 

FS-Edit.   

The main editing requirements are to move blocks of 

lines from the bottom of the file to their required 

location. Recall that the form approach always 

appends the commands to the bottom of the file. 

Single lines can be moved within the file using the  

buttons. 

If the batch files are large it is highly recommended to 

use the editor to add comments to the file. Any 

number of lines can be added to a batch file. If they 

are not valid commands they will be ignored. 
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10. SOLUTION STRATEGIES – STANDARD 3-D ANALYSIS 

Although not specific to Batch operation, an understanding of the underlying solution process will enable 

more efficient batch files to be created for use with the Standard 3-D solver. Also an understanding of the 

underlying analysis process is more clearly understood when it is described in terms of batch commands. 

When solving multiple load cases inexperienced users will often add multiple lines similar to the ones shown 

below, e.g. 20 times in the batch file when solving 20 load cases. The texts shown in blue are the actual 

batch commands for load case 7. 

 

 

 

 

 

 

 

 

 

 

 

An alternative strategy is to use a combination to run the load cases in as indicated below. LC10 contains all 

20 load cases. Using this approach, only 3 lines are used in the batch file. 
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The following shows the more common LFRD solution strategy in which all the load cases are solved in one 

go using C10.  Then at the post-processing stage the factored load combinations are used to produce the 

final result cases. Note that the OFRAME solution ignores the load factors in a combination. 

 

 

Another common strategy is to pre-combine load cases using a combination 

 

 

 

 

 


